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About WorkTime UC Desktop
WorkTime UC Desktop is a native Windows and Mac client or Chrome application for
Unified Communications, providing the following communication features:


Instant Messaging and Presence



Voice Calling (VoIP)



Voice Calling (Desk phone)



Video Calling



Desktop Sharing



Call Settings
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Get Started
This section contains the essential information for getting started with WorkTime UC
Desktop.

2.1

Installation
The download link for the WorkTime UC Desktop client is located in your Hosted PBX
MyPhone portal under My Features  Desktop Client
Windows


Double-click the installer executable and follow the installation instructions.



Launch WorkTime UC Desktop.

OS X

2.2



Double-click the disk image.



Copy the application into the Applications folder.



Launch WorkTime UC Desktop.

Sign In
When you first launch the application, you are prompted to sign in.
1) Enter your Hosted PBX user name and password.
2) Select whether you would like WorkTime UC Desktop to remember your password.
3) Select whether you would like WorkTime UC Desktop to sign you in automatically on
subsequent launches.
4) Click Sign In.
You can also access Help and Preferences directly from the login window.
NOTE: If you choose automatic sign in, you are automatically signed in and taken to the Main
window upon subsequent WorkTime UC Desktop launches. Otherwise, you are presented with
the Sign In screen when launching the application.

The Login window offers the last used username, but the password shall be automatically
filled in only if you have checked the Save password checkbox. If multiple people use the
same machine, only the last password is entered as a security measure. If you change
the username in the Login window through editing it, or using the drop-down list to pick
another one, WorkTime UC Desktop will not fill in the password; you are always expected
to type it in. This also applies when re-selecting or re-entering the last used username.
After logging in, a pop-up dialog may appear informing you about emergency calls, and
another about changing your location for emergency calls. You may also see a banner in
the Main window related to emergency calls. In this case, calling an emergency number
displays a pop-up dialog. A notification message in the Main window may also display. It
is not a supported configuration to run many desktop clients at the same time with the
same account.
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2.3

Main Window
When you start WorkTime UC Desktop for the first time, your Contacts list is empty. Use
the Search and Dial field to find people and add them to your Contacts list. Contacts can
also be added manually by clicking the Add button. Client windows can also be set to be
always using the Main window menu option. The dial pad is also integrated with the Main
window.
WorkTime UC Desktop windows open up in a cascaded fashion in the middle of the
screen while Chrome uses tabs.

Figure 1 Chrome Application
Icon

Usage
My Information – View and update your information, for example, your
presence, avatar, and location.

Contacts – View your contacts.

My Room – This is your permanent communication room. Participants can
dial in to your audio bridge.
Communications History – View previous chats and calls.

Full Enterprise Directory – Show all contacts of the directory.
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Icon

Usage
Dial Pad – Make calls (it is integrated with the Main window).

Web Button – Provides web content inside the Main window or browser.

Preferences – Use for quick access to preferences and call settings such as
Call Forwarding.
Chat – Start an instant message conversation with a selected contact.

Call – Make an IP audio call to a selected contact.

Call from Phone – Make a Click To Dial call from your desk phone (or
secondary device).
Video Call – Make a video call to a selected client (VoIP).

Menu – Open Call Settings, Preferences, and Help.

Add – Add a contact, group, or conference.

My Information
 Click the avatar to update your status or location and enter free text (native desktop
only)


Double-click the avatar to upload a picture or use a right-click menu (single click on
Chrome).



Right-click the avatar to update your status (native desktop only).

Presence
You can set your presence to one status indicated in the following table.
Icon

What it means
The green presence icon indicates that the user is online and ready for communication.
The yellow presence icon indicates that the user is online but has been idle or away from
their computer for more than ten minutes.
The red presence icon indicates that the user is busy and does not want to be disturbed.
The grey presence icon indicates that the user is offline and the only available contact
method is calling or leaving a chat message.
This icon indicates that the contact is busy on a call. This is an automated presence
status.
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Icon

What it means
This icon indicates that the contact is busy in a meeting. This is an automated presence
status. The Busy – In Call status overrides the Busy – In Meeting status so this one is
only seen if there is a meeting but no call.

WorkTime UC Desktop can automatically update your presence to the following:


Busy – In Call



Busy – In Meeting (Windows only)



Available (desk phone)



Available (mobile)



Away on mobile



Offline and busy in call

Location
Your location is automatically determined by your public IP address; however, you can
manually set the text to appear for your location and time zone using the location dialog
box.

2.4

Communications Window
After starting communication with one or more contacts, a Communications window is
displayed for chat and may be displayed for calls depending on your settings (native
desktop only). The call window can also be integrated with the Main window. On
Chrome, a tabbed view is used. From this window, you can perform the following actions:


Escalate a chat to include audio, video, and desktop sharing



End an audio or video call



Open the dial pad



Mute your microphone



Adjust your speaker volume



Place a call on hold



Transfer a call

If you are using several monitors, WorkTime UC Desktop opens the Communications
window as well as notifications on the same monitor as the Main window.
As of Release 21.2.0, WorkTime UC Desktop limits the number of active communications
to spare resources. The limit is 20 active communications on Windows and on OS X. If
the maximum is reached, the main window’s top section warns user with the following
message: “The maximum amount of communication windows has been reached. Please
close some to open new ones.”
If an incoming call is answered while this warning is shown, the client closes the chat
session that has the longest time since its last activity.

2.5

Start Chat
Start a chat using one of the following methods:


Double-click a contact from the Contacts list or search results.
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2.6



Left-click one or more contacts from the Contacts list or search results and click the
Chat button (native desktop only)



Right-click one or more contacts from the Contacts list or search results and click the
Chat button.



On the Communications History list, double-click a chat entry.



In a Communications window, click the Chat button.

Send File


2.7

In a one-to-one chat, transfer files by clicking the Send File button in the
Communications window or use the “drag and drop” method so that they are moved
to the Communications window.

Make Audio or Video Call
Make an audio or video call using one of the following methods:


Left-click one or more contacts from the Contacts list or search results and click the
Call, Call from Phone, or Video button.



Right-click one or more contacts from the Contacts list or search results and click the
Call, Call from Phone, or Video.



Enter a phone number in the Search and Dial field.


Press ENTER to start a VoIP call.



Click the Call, Call from Phone, or Video button.



Open the dial pad, enter a phone number, and then click the Call, Call from Phone,
or Video button.



On the Communications History list, double-click a call entry.



In the Communications window, click the Call, Call from Phone, or Video button.



When viewing a contact’s profile, click the Call, Call from Phone, or Video button.
NOTE: If dialing a phone number that requires additional dual-tone multi-frequency (DTMF)
tones (for example, a conference bridge), you can type the numbers on your keyboard while the
Communications window has focus or open the dial pad in the Communications window.

2.8

Share Your Application or Desktop
Share your desktop by following these steps:
1) Click the Start Sharing button in the bottom of the Communications window (if share
panel is not visible). The Share button is visible by default in My Room also. The
share selector window opens.
2) Select the application to share or the entire screen of a particular display and click the
Start Sharing button.
NOTE: To share your desktop, you must enter your web collaboration credentials in
Preferences → Credentials, For more information, see section 17 Preferences. You can
participate in desktop sharing sessions by another user even without having your own sharing
credentials.
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2.9

Active Communications
Active communications appear at the top of the Contacts list in the Main window (native
desktop only). This area provides an easy view to see the people with whom you are
communicating. By default starting in Release 20.1.0, the call window is shown in the
Active Communications area in the Main window (where the call can be fully controlled in
the desktop client). It reduces the number of communications windows; however, a
separate call window can still be opened using an Active Communications menu. The
following is also available in this area:


Double-click an active communication item to bring this Communications window to
focus if the call window is separately shown. If the call window is integrated, you can
use a menu option to show it separately.



See who has sent you a chat message, but only after you accept the chat session.
Before the chat session is established, the chat items are not visible in active
communications but a history badge is visible.



End a call.



Mute the microphone.



Place a call on hold.



Merge two calls or transfer by dragging and dropping calls onto each other.



Transfer a call.



Make conference calls.



Park and retrieve calls.

Release 20.2.0 and onwards, more buttons can be added to the Active Communications
area:


Conference



Call transfer



Call park

When enabled, you can use the buttons for faster access to the services.
You can right click the “More” icon of an Active Communications item (icon with three dots)
for additional options while left click offers additional call management options for this call.

2.10 My Room
My Room is an always available and permanent room you can use to chat with anyone
that joins.
If you assign a conference bridge to your profile in Preferences → Credentials, then in
your room, you and your attendees can click the Call or Video button to have WorkTime
UC Desktop automatically dial in to the conference and enter the appropriate entry codes.
If a conference bridge is not specified, you cannot initiate a call in your room.
You can invite others to your room by dragging and dropping them from the Contacts list
into the My Room Communications window or tab on Chrome. You can also use the
right-click menu on the My Room icon in the Main window or the menu icon in the My
Room information area to copy an invitation link for guest users (people without WorkTime
UC Desktop). They can then click the link and join the meeting through a web browser.
Guest users must be separately accepted for each session.
Contacts join your room by right-clicking your name on their Contact list and selecting Join
Room or by an invitation you sent.
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Email My Room Invitation menu results in working links for guest users only. WorkTime
UC Desktop users are recommended to use Copy My Room Invitation links; however, the
links may not work in all applications as they were originally intended for Outlook.
2.10.1 Select Audio Devices
If you have multiple audio devices available for your microphone or speakers, select the
preferred audio device before starting a call.
Windows
3) Click the WorkTime UC Desktop logo in the Main window title bar.
4) Select Preferences.
5) Select Audio.
6) Set a playback device (speakers).
7) Set a recording device (microphone).
8) Click OK.
OS X
1) Select WorkTime UC Desktop from the main menu.
2) Select Preferences.
3) Select Audio.
4) Set a playback device (speakers).
5) Set a recording device (microphone).
6) Click OK.
If “Use default” is selected, then WorkTime UC Desktop uses the default device set in the
operating system preferences. For Windows, if “Default Communication Device” is
defined, it is selected over the “Default Device”. If you are using headsets, you can also
select a separate device than the headset for alerting incoming calls.
Note that on OS X it is recommended to disable “Use ambient noise reduction” in System
Preferences to reduce echo.
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Contacts
Contacts are the people with whom you communicate and, in most cases, you see their
presence and share your presence with them. There are three types of contacts:


Contacts – Actual people with whom you communicate.



Conferences – Audio or video conference bridges that you use to communicate with
others. Silent dialing into the bridge also applies to these contacts if enabled.



Groups – Containers of contacts and/or conferences.

There is no hard coded limit on the number of contacts. The more contacts are added the
more memory and processing is needed. The more contacts are added, the more difficult
it is to find people without searching. Live search can be used instead of a very large local
contact list while keeping memory and processing requirements to a minimum.

3.1

Add
When you sign in for the first time, there are no contacts on your contact list. Add a new
contact at any time by selecting the Add Contact item from the menu or choose the Add
Contact button from the Main window.
In the Add Contact dialog box, enter the contact’s information and then click Add Contact.
By default, your presence information is always shared with a new contact if an Extensible
Messaging and Presence Protocol (XMPP) address is provided.
If you are accepting contacts via a buddy request, you may see the contact card after
accepting the buddy request, depending on the settings. When receiving a buddy
request, there are two buttons for accepting and rejecting the request. Dismissing the
buddy request window only ignores the request for the duration of the login session. It
reappears after the next login.
However, you can always share your presence information later by selecting Subscribe on
the right-click menu for a specific contact in the contact / directory list. Note that the
contact must accept your subscription request for you to establish the presence
relationship successfully.
The newly added contact appears on your contact list.
Add a conference contact by clicking the same button you did for Add Contact and
choosing the Add Conference menu option. A conference contact is a special contact
used for conference bridges to avoid remembering PIN codes and conference number, for
example, recurring conferences. Just create a contact for the weekly conference, add a
conference bridge number and PIN, and join the conference just by right-clicking the
contact or choosing it and clicking the Call button.
Choose the Add Group menu option to add a new group to the contact list.
Contact card telephone number fields can also have SIP URIs (work, mobile, extension,
personal, and conference bridge). Release 21.5.0 introduced support for additional
contact card fields.
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3.2

Edit
Edit a contact by selecting the contact first. After you select the contact, right-click
anywhere in the area of the selected contact and a menu of options appears which allows
you to either view or edit the contact profile. In View mode, click the Edit button to go to
Edit mode. This base principle is the same for normal contacts, conference contacts, and
groups. Note that depending on your settings all or no contact card fields may be editable.
Depending on your settings, you may also see a button for synchronizing the contact card
with the Telephony Directory or the synchronization may take place automatically (native
desktop only). When the manual synchronization button (cloud icon) is visible, there is no
automated syncing of the contact card details with server information. To synchronize the
contact card data, click on the cloud icon.


Unsubscribe removes the presence relationship between you and that contact. This
means you do not see the contact’s presence information and your contact does not
see yours. To re-establish the presence relationship, select Subscribe. An
unsubscribed contact remains on the contact list and is always shown without an icon.
Any contact that is not presence-enabled is shown in the same way.



Delete contact removes the contact from your contact list.



View Profile opens the Contact Information dialog box where you can add, edit, or
remove information. This works for both normal and conference contacts.



For groups, choose the Edit menu option to rename a group.

Once done with all changes, click the Save button.

3.3

Filters
You can filter contacts in two ways:


Use the filter field to search by contact name. The contact list is filtered in real time as
you type.



Alternatively, use the filter menus available by right-clicking the Contacts icon in the
left pane to display only specific types of contacts such online contacts (native
desktop only). You can also sort contacts based on first or last name or choose
whether to display the contact’s avatar and availability status in the contact list.

Favorite filtering works slightly differently in Release 21.2.0 and later:


When you make a contact your favorite, the favorite group shows on top of the
contact list and cannot be hidden.



When you delete all your favorite contacts, the favorite group does not show
anywhere.



When you have even one favorite marked, you see the group.
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Presence
For each contact you have subscribed to, you can see their presence. Similarly, your
contacts can see your presence on their contact list.
Presence means that your friends are able to see whether you are available to
communicate, for example, “I’m busy” or “I’m available”.
Icon

What it means
The green presence icon indicates that the user is online and ready for communication.
The yellow presence icon indicates that the user is online but has been idle or away from
their computer for more than ten minutes.
The red presence icon indicates that the user is busy and does not want to be disturbed.
The grey presence icon indicates that the user is offline and the only available contact
method is calling or chatting.
The question mark indicates that a subscription is pending and the contact has not yet
approved sharing their presence.
This icon indicates that the contact is busy due to a call. This is an automated presence
status.
This icon indicates that the contact is busy due to a meeting. This is an automated
presence status. The Busy – In Call status overrides the Busy – In Meeting status so this
one is only seen if there is a meeting but no call.
This icon indicates that the contact is only available on mobile WorkTime UC Desktop.
This icon indicates that the contact is only available on a compatible desktop phone, and not
WorkTime UC Desktop.
This icon indicates that only the mobile client is online and in the away status. This is a
Preview feature in Release 21.5.0.
This icon indicates that the user is in a call but is not logged in to XMPP (presence and
chat). This is a Preview feature in Release 21.5.0.

The avatar in this version is not completely in real time. The avatars are retrieved at login,
when the contact is added, and when the contact comes online. Double-click the avatar to
change it (single click on Chrome). A File Explorer view opens.
If you see an error message at the top of the Main window “XMPP Unavailable”, it means
that the XMPP connectivity has been lost for chat and presence; however, you can still
make calls.
Have the Outlook calendar automatically change your presence to Busy – In Meeting by
enabling this in the Preferences → General tab (native desktop only).
The presence update is only triggered by appointments and meetings that are in the Show
me as busy state.
The XMPP address of a contact cannot be changed. Instead, you must delete the old
contact and create a new one.
Location in presence is done based on the IP address that the machine is using. The IP
address is mapped to a physical location. Change the location manually by clicking the
avatar (if presence controls are not already expanded) and then the location icon to go to
the manual location and change the view.
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Snapshot of presence status is also available in search results and Communications
window for contacts who are not buddies. This presence status is not updated after the
search is done or after the communications session is set up.
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5.1

Chat
Chat View
When you initiate a chat, the Chat window opens. Chatting with a contact is possible only
when you are both online. If your contact initiates a chat, you see a pop-up notification in
the bottom right-hand corner of the screen. If you close the Chat window (or tab on
Chrome) and open it again, sent chat messages are shown in the window as chat history.
When the chat opens, you see the contact’s information at the top of the screen. If you
want to use the whole area for writing, you can press the background of the information or
the top bar. You can contract or expand the information of the contact during the chat and
you can leave it open or closed depending on your preference.
At the top of the message area, there are four links: Yesterday, Last week, Last month,
and All history. From these links, you can load history from your local storage and
different time frames. You can delete the history using the drop-down menu.
In the text field, you can add a smiley emoticon. Smiley emoticons can also be added by
manually entering the corresponding characters that represent that particular emoticon.
You can send text by pressing ENTER.
Emojis are also supported and are rendered as ordinary emoticons when received.
To enter a line break in the text field, you can use the following key commands:


CTRL+ENTER (COMMAND+ENTER on Mac)



SHIFT+ENTER



ALT+ENTER

Use either one of the short commands, CTRL+C or CTRL+V, or right-click the selection
for a menu to copy or paste the text to or from the Chat window.
It is also possible to chat with users in other domains. Hosted PBX also supports Google
federation. Group chat is not supported in Google federation, so the group chat option
with these contacts is shown in grey.
All sent and received chats are stored locally in the chat history and an optional message
history feature provides multi-device enhancements so that messages sent or received in
other own devices would also be shown.

5.2

File Transfer
File transfer functionality is accessible only through the Chat window.
1) To open the File Selection dialog box, click the Send File button located to the side of
the text field.
2) Select the file to be sent from the dialog and then click Open. You can also drag and
drop a file into the Chat window.
3) Once the file offer is issued and during its transfer, you can cancel the transfer (at any
time) by clicking Cancel.
4) Accept an incoming file transfer by clicking the Accept button.
5) Reject the file transfer offer by clicking the Decline button.
After the file transfer has completed, the received files can be opened or viewed in the file
manager by using the File received, click to open, and Show in folder links.
In error situations, partially received files are not deleted automatically.
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5.3

Group Chat
Start a group chat by “multi-selecting” and right-clicking the Main window contact list.
More people can be added later to the chat by “drag and drop”. Only the owner can add
more participants.
A group chat works the same way as a one-to-one chat. All messages from anyone are
sent to everyone else. All contacts need to be online to be able to participate in a group
chat. You cannot invite an offline contact or a contact that is not on a device that supports
group chat. This does not affect the group chat in any way.
A group chat history is saved both in My Room and in ad hoc chat rooms and is available
to view later in the Messages tab of the Main window.
In the text field, the contacts’ names appear in different colors to easily distinguish
between who is writing.
Only the newest chat room messages are stored on the server. One-to-one chat
messages are only saved locally. When the optional Message History feature is enabled,
messages sent from your other devices are also shown.
Deleting a chat room is not supported.
Chat rooms can be moderated by the owner. Use the right-click menu options to remove
a participant from your chat room. If needed, the removed participant can join later. The
removal also applies to desktop share sessions.
Typing notifications are not supported in group chats.
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Audio and Video Calls
The following table describes additional Communications window icons and explains what
you can do with them, for voice and video calls.
Icon

What you can do
Enter additional digits using the dial pad at any time during the call (for example, to
insert a conference number). The dial pad is not movable.

Mute your microphone by clicking the mute icon.

Adjust the volume bar to adjust the volume. Dragging it all the way to the left mutes
your speakers.

Use this icon to access the Call Options menu. In the Call Options menu, you can find
different actions to use for a call depending on your settings.

In the Options menu, there are the following options:


Transfer a call to a third party (native desktop only).



Put the call on hold. Note that if you hold the call, the other party cannot “unhold”.
This freezes a video call to the last frame of the video feed. In both voice and video
calls, this is communicated to all parties by a notification appearing in the middle of the
screen.



Hide or show your own video.



Add participants to the call (native desktop only).

As an alternative, in general available Feature Access Codes (FACs) for call management
work during calls, for instance *55 for direct transfer to voice mail, but the ongoing call
must be put on hold and a new call must be made to the FAC ”number”. Using DTMF for
the same purpose does not work.
When establishing a call to a contact, you can choose several ways to call. Select the
contact you wish to call and press the Call icon. This calls the default number. If you rightclick on the contact you wish to call, you can choose the number to call from a right-click
menu. There can be several phone numbers available in the menu. The work phone is
the default and top most number is followed by mobile and other numbers. This also
applies to the transfer and conference windows. However, in certain cases the
transfer/conference default number can differ from other call options in other menus.
The default call type can also be selected using accessibility menus (Calls → Dialing
service). This controls the default call type when using call buttons.
Dial a number or SIP URI of format user@domain or sip:user@domain in the combined
Search and Dial field to make a call (native desktop only). Once you type your numbers,
WorkTime UC Desktop searches for contacts on both the local contact list and the
enterprise directory.
You can also call circuit-switched network numbers such as Global System for Mobile
Communications (GSM); however, this depends on the network you are using; there is no
technical limitation.
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Choose your video size from the Preferences and the Video tab. Your selection is used
by default for future video calls. The available sizes are automatically presented based on
your camera.

6.1

Call From Computer
Select a contact from your contact list to start communication and click the desired
communication button. Type a phone number in the Search and Dial field at the top of
WorkTime UC Desktop window (search or communicate) to communicate with someone
who is not on your contact list.

6.2

Call From Phone
The second option to communicate in the row of communication buttons is the Call from
Phone. When you click this button, the desk phone instantly starts ringing and the call is
established from your desk phone. This depends on your configuration as other devices
may also ring.
For remote calls initiated using WorkTime UC Desktop, you can also have mid-call
controls such as hold/resume, transfer, and add participant.
Automatic Busy – In Call presence also works with the Call from Phone feature.
Depending on your settings, it is also possible to control calls initiated without WorkTime
UC Desktop in the Active Communications view. The same mid-call controls are also
available in this case. In case of an incoming call, the actual answering action must
happen with the other device.

6.3

Answer Call
When someone is calling you, you see a pop-up notification on your screen. You can
choose to answer, silence the incoming call, and then open a chat session with the caller,
reject the call, or silence the incoming call by closing the pop-up notification window. If you
silence the call, the ringtone is silenced but the caller does not see anything on their end.
You can answer or reject the call after silencing it only if you have chosen the chat option.
If you close the incoming call pop-up notification to silence an incoming call, then you do
not have an option to answer or reject it any more. When choosing the chat option, chat is
only enabled after the call has been answered or rejected.
If you reject the call, it causes the line to sound busy at the caller’s end and they know that
you rejected the call.
When someone is calling you with a video, you see the same pop-up notification;
however, the options are answer with video, answer as voice only, silence and chat,
reject, or silence (by closing the pop-up window). If you decide to answer as voice only,
the call is voice only.

6.4

Contact Name Lookup for Incoming Calls
WorkTime UC Desktop performs a local contact search for incoming calls. If the number
matches one of the contacts on the WorkTime UC Desktop contact list, the name is
shown on the incoming call screen along with the alert. Both the display name and phone
number are shown when available.
If there is no match to a local contact, WorkTime UC Desktop looks for a match in the
Telephony Directory, and if a match is found, the available information is shown for the
incoming call. If there is no match in the Telephony Directory, the display name is taken
from the available information in the incoming call.
Whenever you retrieve your call logs/history, WorkTime UC Desktop does a lookup in the
local contacts and populates the name if a match is found.
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6.5

Missed Call or Communication
When you have one or more missed calls or other types of communications, there is a
notification on the left-hand side of the navigation pane in the Main window. Clicking the
icon takes you to the missed communication in the Communications History view.

6.6

Full Screen in Video Call
Full screen mode can be activated by clicking the Full Screen button or by double-clicking
anywhere on a video.
Exiting full screen mode is done by pressing the Esc key (on both Windows and OS X) or
by double-clicking the window. Exiting full screen makes the video call go back to its
original state (even if there was resizing of the window previously before going full screen).
In a full-size window, you can see a similar Options menu at the top. It has the same
functionality as it does in the normal view. When you move the mouse, the top bar and
lower communication buttons appear on top of the video.

6.7

Multiparty Sessions
You can have many participants in a call, either in a My Room or in an ad hoc multiparty
call (native desktop only). Add more participants by dragging and dropping them on to the
Communications window or by selecting the Conference menu item via the
Communications window menu button. By choosing the menu item, you can also add
participants with just a telephone number.
In contrast to using My Room, which uses your permanent chat and collaboration rooms
and conference bridge, you can start ad hoc multiparty sessions by either selecting
multiple contacts on the contact list and starting a chat, by calling them, or by expanding a
one-to-one session into a multiparty session by dragging and dropping a contact into the
Communications window. In an ad hoc session, the room used is a temporary one that is
deleted once the session ends (that is, when the last participant leaves). Voice
conferencing does not use a bridge but instead uses the Hosted PBX N-Way Calling
supplementary service in a sequential fashion. WorkTime UC Desktop dials out to all
participants and takes everyone off hold after the last attendee answers.
In newer deployments with the Video Server, the ad hoc room created for the session has
a limited lifetime and becomes inactive when idle for too long. In this case, participants
are able to rejoin the ad hoc session if they drop out for some reason. A consequence of
this is that, in ad hoc group calls, participants who are no longer in the call are still visible in
the participant list.
If the XMPP service is not available, then ad hoc multiparty calls are not available.

6.8

Call Waiting
You can have one active call at any one time if you receive a new incoming call and
accept it. The existing call is put on hold and you can change between these two calls by
using the Hold and Unhold buttons.

6.9

Call Transfer
Blind call transfer is available in the Communications window; choose the Transfer Call
menu item to transfer the call to someone else (native desktop only). Attended call
transfer is also available in the same window, first call someone to check if the called party
can take the incoming call and then transfer the incoming call to the desired called party.
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6.10 Message Waiting Indication and Visual Voice Mail (Preview)
Depending on your settings, you can have either Visual Voice Mail (preview feature) or
Message Waiting Indication (MWI) view in your client. Chrome supports visual voicemail
but not MWI.
The MWI service allows you to receive a notification for a waiting voice mail or video mail.
By clicking on the message icon in the upper part of the Main window, WorkTime UC
Desktop calls the predefined mailbox number to allow the user to listen to the voice mail or
view the video mail. With this view, you only have two history tabs: one for calls and
another for chat.
It is also possible to call voice mail from the dialer by long pressing the “1” icon in the
dialer.
When visual voice mail is enabled, a third tab is available, showing visual voice mails.
Click on individual mails to listen to them. Video mail is supported as a preview feature if
enabled.
Missed calls are indicated by an icon in the Main window. Missed video and audio calls
are indicated with a different icon. Note that the MWI icon is in the same place when it
indicates a new voice mail.
Visual voice mail is also supported when enabled. You can see all voice mails in a list and
play them inside the Main window.
The following settings are needed on CommPilot portal to have visual voice mail:


Voice messaging enabled



“When message arrives, use unified messaging” option enabled



“Use Phone Message Waiting Indicator” option enabled

6.11 Call Park and Retrieve
Call Park is particularly suited for shared environments where one person can answer the
call, park it, do something else for a while and continue the call from another device or let
somebody else continue the call (supported on native desktop only).
Transfer an ongoing VoIP call to a Call Park server and then retrieve it when needed.
An ongoing call can be parked against your own number or another number (an
extension). Call Retrieval works in the same way, the parked call can be retrieved from
your own number (an extension) or another number (an extension) to provide flexibility for
who is picking up the parked call.
A parked call is visible on your desktop in the Active Communications area so that you can
easily retrieve it, but only for the duration of the Hosted PBX Call Park announcement.
After the announcement is over, the parked call disappears from the Active
Communications area (since the triggering call is disconnected). After the call disappears
from the Active Communications area, the user must remember the extension to which
the call has been parked to retrieve it using the Main window menu (or feature access
code), unless the call was parked to the one’s “own” extension. If the call is not retrieved
after a certain time, then the server calls the parking user.

6.12 Call Pull
Call Pull allows you to pull an ongoing call from one of your devices to another one where
the Call Pull feature is used (native desktop only). Call Pull can also be used with Feature
Access Codes (FACs), in this case, *11. In this release, user interface support has been
added to the desktop so that an end user does not have to remember FACs.
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6.13 Moderator Controls
You can control the functionality available to participants if you are the owner of the
session in My Room. You can do the following:


Dismiss one or more participants. This ends all sessions (group chat, audio, video,
and share) when the participant is using WorkTime UC Desktop.



Mute one or more participants.



Lock or unlock the room (when locked, no additional participants can join).



See active talker indication.



See full audio participant list.

To invoke the features, you can use either the right-click menus or you can click on the
moderator control icons of a participant. Note that most features are not available via
icons. To dismiss or mute all participants or lock the room, use the right-click menus
available for your own icon at the top of the participant list.
If you are not the owner, you can only see the XMPP (chat) participant list or the full
participant list along with mobile participants (depending on your settings).

6.14 Forced Logout
Depending on your settings, you may see a pop-up saying that you have been logged out
due to another instance of the client logging in (native desktop only). This feature allows
Hosted PBX to track similar online client instances and only allow one of them to be online
at the same time. When Hosted PBX notifies the client to log out, all connections are
terminated and client returns to the login window.

6.15 Headset Support
You can control incoming and ongoing calls from a compatible headset. The feature set
supported is answer/hang up as well as mute/unmute. Volume control operations are not
reflected in the WorkTime UC Desktop UI. The following is a list of tested example
devices, although other devices should also work:


Plantronics Voyager Edge UC



Plantronics Savi 700 series



Plantronics Blackwire C3xx, C4xx, C5xx, and C7xx



Plantronics Calisto 620



Plantronics Voyager Legend UC



Logitech H570e Mono



Logitech BCC950



Logitech Conference Cam Connect



Jabra Biz 2300/2400



Jabra Speak 510



Jabra Pro 930 (wireless)



Sennheiser SC 230/260



Sennheiser SP 20



Sennheiser MB Pro1 UC
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Headsets typically use an add-in of some kind to communicate with the rest of the client
while calls are made. Currently, installed add-ins are visible in Preferences Add-ins tab.
These vendor-specific add-ins would be installed during new headset installation;
however, the standard HID add-in should remain in the preferences list. If for some
reason it has disappeared, adding the respective .dll file back to the add-in folder should
make it visible again in the preferences. If later on you would like to change to another
headset, the vendor-specific add-in could be disabled from preferences to again use the
standard HID or some other new add-in by another headset provider.
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7

Application or Desktop Share
To share your desktop or individual application:
1) In the Communications window (or tab on Chrome), click the Start Share button
(Screen Share on Chrome). This does not yet start the “share”.
2) Select either to share your entire display or one of your open applications and click
Start Sharing. On Chrome, click the Start Share button again to select the
application and screen to share.
The share widget appears to let you control share settings such as Preview that
shows you what participants are seeing and Pause that pauses sharing.
3) To stop sharing, click the Stop icon. While sharing, all other communications
mechanisms are also available except for video calling and file transfer. Participants
cannot hide a share without closing the Communications window. Video call is also
available while sharing.
Desktop sharing works the same way in both My Room and in ad hoc sessions. For
participants without WorkTime UC Desktop, use the separate Desktop Share Invitation
link, if available, by right-clicking the My Room button. Share selector is not dynamically
updated while the selector is open and minimized applications are not available in the list
of applications to share.
If you are first in a video call and then start share, your own video is not shown due to
limited space available, but you can make it visible using the Main window menu in the
bottom right-hand corner by selecting “Show Own Video”.
If you are using dual monitors, you can choose which monitor to share. You can check
the primary monitor in the operating system settings.
You can also remove desktop share participants. They are also removed from the group
chat at the same time. If needed, the removed participants can join later.
Depending on your settings, you may have to provide desktop share credentials manually.
In addition, participants can share when enabled by clicking on the Share button; however,
the room owner can prevent this at any time. Only one person can share at any one time
in a session. Only one share at a time is supported if you have sessions with many users
at the same time. Share passing is only supported in My Room.
Participants do not have to take any action to accept share invitation. It is automatically
accepted. The same also applies to share passing. That is, the owner does not have to
take action for participant to start sharing.
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8

My Room
My Room is started by clicking on the My Room icon on the left-hand side of the
navigation pane. My Room is started automatically using your permanent chat room. Add
more participants by dragging and dropping them into the Communications window (or tab
in Chrome) or the Conference menu, or they can join your room by right-clicking your
name on their contact list and choosing the Join Room menu option. Once people have
joined the chat room, they can click on the Call button of that window to join the
conference. The room owner can also share their desktop.
To use the full functionality of My Room (desktop sharing, conferencing, and chat
combined), you may have to manually enter your desktop sharing credentials, your
conferencing number, and your PIN in the Preferences → Credentials window. This
depends on your settings.
In addition to the owner of the room, participants can also share the desktop but only the
owner can add more participants. This applies to both My Room and ad hoc sessions.
1) To see a Context menu, right-click the My Room icon on the left-hand side of the
navigation pane (native desktop only).
2) To modify credentials and conference bridge information, select Configure to go to the
preferences.
3) Select My Room Invitation (or, for example, Copy My Room Link on Chrome) to copy
an invitation link to the operating system clipboard (depending on your setup, this
menu option may not be available). Paste this link, for instance, to meeting invitation
e-mails to allow WorkTime UC Desktop participants to join the conference in one click
from, for example, Outlook, or Office applications. Note that some applications may
not recognize the WorkTime UC Desktop link. You can also copy the My Room
Invitation to the default email client (this text does not contain the WorkTime UC
Desktop link) and go to the My Room preferences via a right-click menu option.
The link has two parts: one for WorkTime UC Desktop users and another one for
users with some other client. Depending on your settings, the invitation can also
contain a link to the desktop sharing session. The invitation always contains a dial-in
number and PIN for users who do not have WorkTime UC Desktop. The desktop
share link, when available, allows anyone to join a desktop share session from a
standard web browser. In addition, the WorkTime UC Desktop group chat session is
supported with the web collaboration session. For guest user links, see the next
section.
The My Room icon also has a tooltip indicating the conference bridge details of your
My Room.
The Communications window also has an icon that provides the same Context menu
previously discussed.
For more information on desktop sharing, see section 7 Application or Desktop Share.
Desktop sharing works the same way for both My Room and the ad hoc sessions.
My Room uses your permanent chat room, permanent collaboration room, and
conference bridge (audio or video). My Room is the only way to use the permanent
rooms. Any other multiparty communications, such as selecting multiple contacts, and
right-clicking for a conference call, or dragging and dropping for a one-to-one chat, is done
using ad hoc rooms. Ad hoc rooms are deleted once the session is over.
All My Room sessions start as chats but call and/or share can be added to the session
while in progress. File transfer and video conferencing are not supported in My Room or
ad hoc sessions.
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8.1

Guest Client
Previously it was not possible to join a full My Room session with a web browser. Guest
client allows you to do that.
This feature is especially intended for users outside of the company. Generate separate
invitations for guest users using My Room right-click menu items as described in the
previous section. My Room invitations are generated using separate menu items and are
intended for WorkTime UC Desktop users.
Guest users can join a session with audio in the web browser by requesting a callback
using the provided dial-in number and conference PIN as well as use group chat and
sharing inside the web browser. However, guest clients do not have private chat
possibility and they can see the chat history of messages that occurred after they joined
the session.
The invitations persist until reset via a separate right-click menu item. Individually accept
each joining guest participant. Not doing this in a predefined period of time results in the
invitation becoming obsolete and guests not being able to use the link to join.
After dismissing a guest user from share and chat, the audio/video portion can remain.
The following OS and browser combinations are supported if Web Real-Time
Communication (WebRTC) is disabled:


Latest Chrome on Windows (Windows 7, Windows 8 [Classic], and Windows 8.1
[Classic]) and OS X (10.8 and 10.9)



Internet Explorer 11 on Windows (Windows 7, Windows 8 [Classic], and Windows 8.1
[Classic])



Safari 7 on OS X (10.8 and 10.9.)

The following OS and browser combinations are supported if WebRTC is enabledr:


Latest Chrome on Windows (Windows 7, Windows 8 [Classic], and Windows 8.1
[Classic]) and OS X (10.8, 10.9, and 10.10)

For more information on guest client usage, see Appendix B: Guest Client Usage.
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9

Search
WorkTime UC Desktop supports a search of the enterprise directory as well as the
personal directory, enterprise common directory, and group common. Chrome also
supports Google contacts. This takes place in the same Search field that is used for both
a local and presence-enabled contact list search. The various directories have different
purposes with the enterprise directory having the most data, and not all directories may be
used in all deployments. All search results are combined into one common set of results.
Personal directory, enterprise common, and group common directories cannot be
modified from the client side. Only read access is provided. A snapshot of the presence
status of the contact in the results list is shown, but this presence is not updated after the
search operation.
Personal directory provides your own special contacts that are not in the enterprise
directory, for instance, partner company’s numbers while group common contains, for
example, the group’s contacts such as favorite pizza taxi.
WorkTime UC Desktop automatically searches the local contacts and presence-enabled
contact list in addition to the enterprise and other directories at the same time. As soon as
there are results from the enterprise and other directories, these results are shown on a
separate list in the Main window. Additionally, there may be other search result groups
from other search sources such as Lightweight Directory Access Protocol (LDAP) or
Outlook (native desktop only).
Search results are displayed differently depending on the results of the contact list and
directory search:


If LDAP search (Corporate directory) or Outlook search are enabled, there are more
result groups.



If there are no results for a certain search source (for example, local contacts,
Outlook, LDAP, or Hosted PBX Telephony Directory), then that group is different in
the UI.

The enterprise directory searches all available fields for the search string. By default, it
waits for 1.5 seconds before it sends the search request to the server to minimize
unnecessary load on the server.
Release 21.5.0 introduced support for showing phone number in the search results to
better distinguish similar search results. In addition, tooltips are provided for search
results.
Typically, when adding a contact using directory search results, there are phone numbers
and first names in addition to last names available. In addition, the Extensible Messaging
and Presence Protocol (XMPP) address and other fields are imported when found to allow
presence and chat.
LDAP search (Corporate directory) needs to be enabled. In addition, you must manually
provide your LDAP credentials in the Preferences → Security tab. LDAP search results
are provided in the corporate directory group in the search results.
Outlook integration (search and calendar integration) on Windows requires one of the
following versions installed on the desktop:


Outlook 2007



Outlook 2010



Outlook 2013



Outlook 2016
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Outlook search also works when several Outlook accounts are in use, but only one
account is used at a time (default selected, which can be changed in Outlook).
Additionally, other related considerations are as follows:


The client searches for contacts and calendar entries in the default Outlook account.
The account is set to the default via File → Info (left pane) → Account Settings →
Account Settings → Data Files. Select an account and mark it as “Set as Default”.
After making this change, sign out and sign back in to the client and it now searches
that account for contacts and calendar entries.



The client searches the Outlook contacts only on the local machine (that is, the
Outlook Address Book). There is no Exchange server lookup performed. In addition,
all directories in Outlook are searched for contacts, even deleted folders. The
Contacts directory can also have multiple levels of subfolders.

Every minute, WorkTime UC Desktop reads Outlook appointments. If there is an
appointment running at the current time, then the presence is shown as Busy – In
Meeting. Overlapping appointments are also handled. Following are some examples of
WorkTime UC Desktop operation with Outlook when time is 9:10 A.M.


There is meeting “A” 9 A.M. through 10 A.M. Presence is shown as Busy – In
Meeting.



Presence is explicitly changed to Available at 9:15 A.M. Presence is shown as
Available.



In the next minute, WorkTime UC Desktop again reads the appointments and sees
that “A” meeting is running; however, the presence was already explicitly marked as
Available and presence is not shown as Busy – In Meeting but Available.



There is an overlapping meeting “B” 9:30 A.M. through 10:30 A.M. Presence is
shown as Busy – In Meeting when the time is 9:30 A.M.

When deleting a meeting that is currently ongoing in Outlook, the presence status remains
as Busy – In Meeting until the next time Outlook appointments are checked (once every
minute) and after that, presence is shown as Available. This change may be
instantaneous or it may take a minute depending on how close the timer is to being
triggered.
The Outlook Object Security model was introduced in Outlook 2007. It has been tested
with Outlook 2010 and Outlook 2007. For Outlook versions prior to 2007, the Allow/Deny
pop-up window seen in previous releases should not be triggered. However, those
versions are not officially supported. For Outlook 2013, the behavior should be similar to
2007 and 2010, meaning the pop-up should not come up with Outlook 2007, 2010, and
2013 in Release 20.0.0 and onwards. However, more tests are needed for this before
official support for Outlook 2013 can be declared.
The presence update is only triggered by appointments and meetings that are either
accepted by the user or made by them. All day meetings do not trigger a presence
change to Busy – In Meeting.
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10 Full Enterprise Directory
WorkTime UC Desktop allows for browsing of an entire Hosted PBX enterprise directory.
To view the Hosted PBX enterprise directory, click the Directory button on the left-hand
side of the navigation pane (if available). This feature depends on the configuration so it
may not be visible in all clients.
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11 Communications History
The fourth icon from the top in the Main window on the left-hand side of the navigation
pane displays your messaging history. History view is divided into one, two, or three tabs
depending on your settings. Possible tabs are:


Calls



Chat



Visual voice mail

Double-clicking a conversation on the chat tab list opens it in a new window while doubleclicking a call history item calls that number. Clicking a visual voice mail downloads the
message so you can play it.
WorkTime UC Desktop saves a call history for placed, received, and missed calls. The
call history makes it easy for you to redial and call back when you have missed a call or
you want to easily dial a contact with whom you have recently spoken. Each call has a
separate entry in the list.
Chat history for group chats, both in My Room and in instant group chat, are stored locally
on the desktop client, just like in one-to-one chat, but only for the time the user is joined
into the session.
Double-click on a name in the list to call back directly (this calls back the same way you
previously spoke, for example, if you were in a video call, double-clicking starts a new
video call). Double-clicking an incoming call item in the Calls tab makes a call.
To clear the missed chat indicator, you must open the missed chat.
The Communication History missed communications badges can be cleared by using the
right-click menu from the Communication History button on the left pane (native desktop
only). The menu provides options to mark “All as viewed”, “Chats as viewed”, “Voicemails
as viewed”, and “Calls as viewed”.
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12 Click-to-Call (Highlight Text)
Release 21.5.0 of WorkTime UC Desktop introduced support for Click-to-Call using
highlighted text and global keyboard shortcuts. Users can highlight text anywhere in the
desktop machine to make a call and define the default call type used for making the call
using the shortcut defined in Preferences. On OS X, you need to define the shortcuts on
your own using the instructions provided in Preferences.
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13 Web Button
As a option for integrating third-party web content onto WorkTime UC Desktop desktop, a
left pane icon may be visible. When clicked, it opens predefined content either in the Main
window or on a separate web browser. Both single and multiple links may be present.
In addition, local applications can be used in the links, for instance, email. This depends
on your configuration.
Cookies are supported starting in Release 21.3.0. The saved cookies are stored in
cookies.dat that can be accessed from Preferences view → General tab by clicking on the
Open folder button and navigating one directory level up. To remove old cookies, first
exit WorkTIme, then remove the file and sign back in. Failing to exit the client results in
recreating the cookies.dat with cookies from memory.
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14 WorkTime Add-In for Microsoft Skype for Business
WorkTime UC Desktop supports integrating with Microsoft Skype for Business (WorkTime
Skype for Business) (native desktop only). The intended main use case is using
WorkTime UC Desktop for non-WorkTime Skype for Business calls such as calls to
mobile while presence, chat, and WorkTime Skype for Business-to-WorkTime Skype for
Business calls still take place via WorkTime Skype for Business.
Existing WorkTime Skype for Business integration with, for example, SharePoint, Office
365, and Internet Explorer can be used so that calls can be made from those applications.
Usual WorkTime UC Desktop call control features such as hang up, mute, transfer,
conference, and Call Park are supported. WorkTime UC Desktop call logs and call
settings are also available in this configuration.
WorkTime UC Desktop also updates phone presence on the WorkTime Skype for
Business side.
WorkTime UC Desktop must be started after WorkTime Skype for Business for calling to
work smoothly.
For detailed calling examples, see Appendix C: Skype for Business Integration. For a
general overview of this feature, see the WorkTime Add-in for Microsoft WorkTime Skype
for Business Product Guide.
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15 Emergency Call Address Change Service
Depending on settings, a special dialog can be shown at login, asking if the (physical)
address needs to be updated (native desktop only). If not, login proceeds normally. If the
user replies “yes”, a web browser opens with the possibility to update the physical address
for emergency calls. Once the address update is complete, login continues.
Depending on settings, a separate Emergency Call Address Change Service (ECACS)
menu item may also be visible in the Main window. This menu item allows the ECACS
service to be invoked at any time after login.
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16 Accessibility Compliance
WorkTime UC Desktop supports accessibility compliance starting in Release 21.3.0 by
having all client features available in menus at the top of the Main window (native desktop
only). The menu items are also available using the keyboard shortcuts listed in Appendix
A: Keyboard Shortcuts for Desktop.
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17 Preferences
Preferences provide access to available settings for WorkTime UC Desktop. Follow these
steps to access Preferences.
Windows and OS X
1) Click the Preferences logo in the Main window left pane.
2) Select the desired view from the drop-down.
or
Windows and OS X
1) Go to the WorkTime UC Desktop accessibility menu.
2) Select Preferences.
3) Select the desired view from the drop-down.

17.1 General
Language
Select your language then click OK or Apply and the change takes effect immediately.
Note that the number of languages depends on your.
Login
Enable or disable automatic login when starting the application and control the remember
password feature as well as enable the Update Password feature.
Notifications
Usually there is a confirmation pop-up notification each time you remove a contact or chat
history record. By selecting one or all of the check boxes, you can disable the
confirmations when deleting information. You can also control whether there is always a
pop-up notification for publishing location information. Typically, this is shown at login.
You can also select whether to receive a notification before ending communication or
holding a call.

17.2 Media
Audio
Output Device (Voice Playback)
Choose a headset, PC-integrated speakers, or external speakers for audio output. Your
external playback device is selected by default (if you have one connected).
Input Device (Voice Recording)
Choose a headset microphone, PC-integrated microphone, or external microphone for
voice during calls. Your external recording device is selected by default (if you have one
connected). You can also choose automatic gain control and test your recording device.
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Microphone
Ring Device (Alert Signal)
Select the audio device that is played when you receive an incoming call.
Ring Signal
You can select your own ring signal. The same signal is used for both voice and video
calls.
You can also select an icon to play a tone for incoming messages. To disable the tone,
uncheck the icon. Select a sound event and then click Play to hear the sound.
Video
Capture Device (Video)
Select a camera that you want to use for video calls. Your external web cam is selected
by default (if you have one connected).
Video Size
Select one of the available sizes. Note, however, that higher sizes require more
bandwidth and a more capable central processing unit (CPU).
Click Test Call to make a test call to test voice quality.

17.3 Advanced
The Advanced view contains three different subsections:
 Logging


Proxy



Credentials

Logging
Logging is used for troubleshooting. You may be asked by your to turn on logging and
then send a log file directory contents. You can choose basic logging or more detailed
logging to be enabled. Detailed logging may consume memory resources so it is not
recommended to have it enabled for a long period of time.
You can also clear the logs and open the logging folder.
Proxy
Select how to handle HTTP proxies. By default, the system settings are used but you can
also choose not to use an HTTP proxy or to use the WorkTime UC Desktop (client) proxy
settings.
Credentials
Configuration URL
If the Device Management configuration URL is available to be viewed, it appears here.
IM Address
If XMPP credentials are available to be viewed, they appear here.
Hosted PBX ID
This is the username you use to log in.
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18 Call Settings
WorkTime UC Desktop supports the following service management features allowing
supplementary services to be managed using the Preferences and Call Settings view
available in the Main window left pane by selecting the appropriate sub-view in the drop
down:


Incoming calls


Office Anywhere



Remote Office



Forward Calls



Do Not Disturb



Simultaneous Ring



Anonymous Call Rejection



Call Waiting



Voice Messaging



Outgoing Calls


Block My Number (Calling Line Identification Presentation [CLIP]/Calling Line
Identification Restriction [CLIR])



Automatic Callback



Highlight to call

You can also use the call settings with a Main window toolbar on the top of the window, if
this feature is enabled. When enabled, this feature allows Anywhere, Do Not Disturb,
Remote Office, and Call Forwarding to be managed in the Main window using single clicks
or right clicks. From Release 20.2 onwards, the Call Settings toolbar is an icon in the left
pane with right-click menus.

18.1 Office Anywhere
Office Anywhere simplifies communications for on-the-go users and remote users by
extending the features of a desk phone to any other fixed or mobile device, regardless of
the network or handset manufacturer. Callers dial one number and can reach you on any
phone the user chooses. A desk phone, cell phone, and/or a soft phone may ring
simultaneously.
Experience voice call continuity with the ability to move live calls from one device to
another without hanging up.
Add locations (numbers) that can be used in the service via the Add Number field. Use
the Alert all locations simultaneously check box to activate parallel ringing. Click on the “+”
icon to see more options.
The Don’t divert check box prevents a call from ending up as a voice mail, which can be
problematic in, for example, conference call situations.
Select Answer Confirmation to receive a separate audio prompt when answering a call
from that number (location). It may be useful in cases where, for example, mobile
numbers are being used to prevent incoming calls going to mobile voice mail since the call
will be ended without going to voice mail if the answer confirmation is not provided.
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Select the Call Control check box to enable the server platform to provide mid-call
services such as Call Transfer and Conferencing for that number (location).

18.2 Remote Office
This service allows the use of any phone as the office phone from a charging and
numbering perspective. For instance, a hotel room phone can be used as the office
phone.
Enable Remote Office by clicking the service icon and specifying a phone number to be
used as the Remote Office number.

18.3 Forward Calls
Enter a number to which your calls should be forwarded. Different variants of Call
Forwarding are supported, such as forwarding always, forwarding when busy, and
forwarding when you cannot answer or when you are unreachable. In addition, you can
specify the number of rings before call forwarding is triggered.

18.4 Do Not Disturb
When you activate this service, all calls are typically blocked by the server and are sent to
voice mail. Enable this service by enabling the service icon.

18.5 Hide Number
You can hide or display your number when calling or communicating with other parties or
contacts. Hide your number by enabling the service icon. To show your number, set this
to “Disable”.

18.6 Simultaneous Ring
Add up to 10 additional numbers or Session Initiation Protocol Uniform Resource Identifier
(SIP-URI) addresses that you would like to ring in addition to your primary number when
you receive a call. In addition, specify whether you want answer confirmations and if you
would like to receive calls when already on another call. This service is an older variant of
Office Anywhere.

18.7 Voice Messaging
You can enable or disable voice messaging in the Preferences and Incoming Calls tab. A
number of settings are available:


Send all calls to voice mail.



Send busy calls to voice mail.



Send unanswered calls to voice mail.



Specify how voice mail messages are handled using an indicator in WorkTime UC
Desktop or forwarding to e-mail.



Enable notifications of new messages via e-mail.



E-mail a carbon copy of new voice mail.



Transfer incoming calls to a specified number using “0” DTMF.



Specify how many rings are used before sending an incoming call to voice mail.



Allow/disallow callers to leave a message.
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18.8 Anonymous Call Rejection
The Anonymous Call Rejection service allows you to reject calls from parties who have
explicitly restricted their identities.
You can enable or disable anonymous call rejection in the Preferences and Incoming
Calls tab.

18.9 Automatic Callback
The Automatic Callback (ACB) service allows you to be notified when the previously called
busy party becomes idle and is connected without having to redial the phone number.
When you call another party and the call cannot be connected because the line is busy,
you are prompted to make an automatic callback request (for example, “The line you are
calling is busy. Press 1 if you would like to be notified when the line becomes available”).
If you select Automatic Callback, the system monitors the busy party and automatically
establishes a call when the busy party becomes available.
You can enable or disable Automatic Callback in the Preferences and Incoming Calls tab.

18.10 Call Waiting
The Call Waiting service allows you to answer a call while already engaged in another call.
You can enable or disable server-based call waiting in the Preferences and Incoming Calls
tab. If you disable Call Waiting, the second incoming call will not be connected and the
caller hears an announcement that the call cannot be completed.
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Sign Out
Signing out of WorkTime UC Desktop sets your status to “Offline” for your contacts and
displays the Sign In screen.

18.11 Sign Out of WorkTime UC Desktop
To sign out, follow these steps.
Windows
1) Click the WorkTime UC Desktop logo in the Main window title bar.
2) Select Sign Out.
OS X
1) Select Actions from the main menu.
2) Select Sign Out.

18.12 Exit Application
To exit the application completely, follow these steps.
Windows and OS X
Close the Sign In window.
Windows
1) Select the WorkTime UC Desktop logo in the Main window title bar.
2) Click Exit (a keyboard shortcut can also be used).
OS X
1) Select WorkTime UC Desktop from the main menu.
2) Select Quit WorkTime UC Desktop (a keyboard shortcut can also be used).
NOTE: Closing the Main window (not the Sign In window) does not exit the application but
rather minimizes the application to the system tray (Dock). This allows you to continue to
receive calls and messages without having the Contact List window appearing on the desktop.
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19 Installation
Installer supports a number of options on Windows (native desktop only):


Agree to the license agreement.



Run when system starts (can be changed later in Preferences window).



Create a desktop icon.



Select destination folder for installation.



Select name of the software in Program menu.



Launch client after installation.

When installer has been run on an end user’s behalf by an administrator, the “Run
program when system starts” option cannot be changed that end user.
If you disable startup, for example, in the Task Manager's Startup list (on Windows 8 and
10) or from msconfig.exe on Windows 7, the change is not reflected in Preferences. The
checkbox remains checked and grey even though the client is not actually started
automatically when the system starts.
When WorkTime UC Desktop is installed for the first time, you can choose the language if
many languages are supported in the installer. The default language is the language of
the operating system; if that cannot be found, English is used as the fallback.
In Release 21.5.0 and later and depending on your settings, the Outlook Add-in installer
may be bundled together with the WorkTime UC Desktop installer.
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20 Uninstallation
The uninstallation procedure is different for Windows and OS X.
Windows
Uninstallation is performed by launching the Windows uninstaller via the Start menu or by
using the Windows “Remove programs” view inside the Control Panel. Windows
uninstallation does not require you to select any options.
All files are deleted at uninstallation, except for the following files:


Registry entries



Account files are only deleted when explicitly allowed by the end user on Windows.

OS X
Uninstalling is performed by simply dragging the application folder from the Applications
directory to the trash can; however, account files are not deleted. If you want to remove
account files, they must be manually deleted.
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21 System Requirements
System requirements are as follows on native desktop:


Operating system: Mac OS 10.9 Mavericks, Mac OS 10.10 Yosemite, Mac OS 10.11
El Capitan, Windows 7, Windows 8/8.1, or Windows 10 (Classical view only).



The installation footprint is approximately 125 megabytes (MB) on OS X and 215 MB
on Windows.



For voice calls, a sound card, speakers, and a microphone or a headset are required.



For video calls, a web cam is required.

Minimum system requirements for respective operating systems need to be fulfilled, with
the following additions:


A minimum of 2 GB random access memory (RAM) is required.



A minimum 1.5 GHz CPU is recommended. A dual core CPU is recommended for
video calls at a minimum.



Open Graphics Library (OpenGL) 1.5 or higher is recommended.

For high definition (HD) video, the following is recommended:


HD camera



HD resolution support in display



Quad Core x86 or equivalent at a minimum



2 GB RAM
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22 Troubleshooting
Why can’t I chat with contacts from Yahoo?
Chatting with users in other domains is possible, but depends on the domain. For
instance, Hosted PBX supports Google federation but not Yahoo. However, group chat is
not supported in Google federation, so the group chat option with those contacts is shown
in grey.
Why can’t I change the avatar?
Double-clicking the avatar should open a File Explorer view to select a file. If your XMPP
connection is lost, changing the avatar does not succeed. A lost XMPP connection is
indicated in the Main window’s top notification area.
My contacts are all offline and my client’s status bar says “XMPP unavailable”.
What does this mean?
It means that the XMPP connectivity has been lost for chat, as well as for presence;
however, you can still make calls.
Why am I offline?
If you have selected “Offline” status, you are shown as offline to others. Another possibility
is that you may have lost your Internet connection. In this case, the client does not log out,
but rather enters an offline mode where a contact list is available but communication is not
possible.
Why can’t I have more video resolutions available?
You can choose your video resolution from Preferences and the Video tab. Your selection
is used by default for future video calls. The available resolutions are automatically
presented based on your camera.
Why can’t I change my user name and password?
User name and password editing is not supported in the client. To edit your user name or
password, contact care. The exception is login password expiry. When it expires, you
can change the password in a separate dialog window.
In the preferences, the client only supports changing LDAP credentials. Desktop sharing
credentials may also be changed, depending on your settings.
Why does my all day calendar entry not trigger Busy – In Meeting presence status?
Not all meetings trigger a presence change to Busy – In Meeting.
To trigger the presence update, the meeting must be in the Show me as busy state.
Why aren’t all my group chat messages saved?
Only the newest chat room messages are stored on the server, but never for My Room for
security reasons. Starting from Release 21.3.0, when the optional (Preview mode in
Release 21.3.0 and fully supported in Release 21.4.0) message history feature is enabled,
messages sent from other devices are also shown.
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Why aren’t all my chat messages available in my other devices?
All one-on-one and group chat messages are saved, but only locally, so they are not
necessarily available in your other devices. Incoming messages are sent to all devices;
however, the ones that you send are only stored in the device that you are using to send
the message. Starting from Release 21.3.0, when the optional (preview in 21.3.0)
message history feature is enabled, messages sent from other devices are also shown.
Why can’t I change the XMPP address of a contact?
This is not supported in this release. However, you can delete the contact and add a new
one.
Why does my location show an incorrect address?
It is done based on the public IP address that the machine is using. The IP address is
mapped to a physical location. You can also manually change the location by clicking the
avatar and changing the location icon.
Why can’t I start desktop sharing?
To share your desktop, you need to have valid credentials, either by manually entering
desktop sharing credentials in the Preferences → Credentials window, or by using autoprovisioning to enable the desktop sharing menu items and icons. However, you can
participate in desktop sharing sessions even without any sharing credentials. Your
settings dictate if auto-provisioning is enabled or not.
Why can’t My Room participants share the desktop?
Only the owner of the room can share the desktop before Release 21.2.0. Starting in
Release 21.2.0, participants can also share when enabled. This applies to both My Room
and ad hoc sessions.
I have a USB headset and the call control features are not working. Is there
anything special I need to do to enable call control support?
In order to use headsets on Windows (not supported on OS X), several steps are needed:
1) When the client is started, you must accept the API connection request from the
connector/add-in device.
2) Additionally, your client must have the feature enabled.
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Appendix A: Keyboard Shortcuts for Desktop
The following table lists the currently supported keyboard shortcuts (native desktop only).
You can use these keyboard shortcuts to quickly perform frequently used actions. The
characters used are lower case. The shortcuts are also indicated in the accessibility
menus.
Shortcuts
for Windows

Shortcuts
for Mac

What it does

CTRL-Q

Cmd-Q

This quits the application.

Alt+F4

Cmd-W

This closes the selected window (except for a contact card and
the About window).

CTRL+C

Cmd-C

This copies selected text from WorkTime UC Desktop to the
clipboard.

CTRL+V

Cmd-V

This pastes text from the clipboard to the location selected
using the cursor in WorkTime UC Desktop.

CTRL-X

Cmd-X

This cuts the selected text to clipboard.

Enter

Enter

When in the Communications window, this sends a chat
message (if the Chat view is visible).
When in the contact list, this opens a chat with the selected
contact.
When in the Communications History, this opens a
communications session with the contact or address related to
the selected item. This opens a chat if the item was chat and a
call if the item was a call.

-,

Cmd-,

This opens Preferences.

F1

Cmd-?

This opens Help.

CTRL+A

Cmd-A

This selects all text in the Chat view.

-

Cmd-H

This hides WorkTime UC Desktop.

-

Alt-Cmd-H

CTRL-N

Cmd-N

Shift-CTRL-N

Shift-Cmd-N

CTRL -1

Cmd-1

When a contact is selected, this opens a chat session with the
contact.

CTRL -2

Cmd-2

When a contact is selected, this calls the contact with audio.

CTRL -3

Cmd-3

When a contact is selected, this calls the contact using call
from phone.

CTRL -4

Cmd-4

When a contact is selected, this calls the contact with video.

CTRL -5

Cmd-5

When a contact is selected, this joins his room.

CTRL -6

Cmd-6

When a contact is selected, this opens an email-sending
window using the default email client.

CTRL -I

Cmd-I

When a contact is selected, this opens the contact card for the
contact.

Shift-CTRL-F

Shift-Cmd-F

When a contact is selected, this makes the contact a favorite.

CTRL-delete

Cmd-delete

This deletes the selected contact.
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This hides other windows other than WorkTime UC Desktop.
This opens the Add Contact window.
This opens the Add Group window.

Shortcuts
for Windows

Shortcuts
for Mac

What it does

CTRL-arrow
down

Cmd-arrow
down

This decreases the volume.

CTRL-arrow
up

Cmd-arrow up

This increases the volume.

CTRL-space

CTRL-space

CTRL-D

Cmd-D

This turns on the Do Not Disturb service.

CTRL-P

Cmd-P

This pulls an ongoing call from your other device to WorkTime
UC Desktop.

Alt-shiftCTRL-P

Alt-shift-Cmd-P

-

Alt-Cmd-2

This calls your voice mail with audio.

-

Alt-Cmd-3

This calls your voice mail with audio using call from phone.

-

Alt-Cmd-4

This calls your voice mail with video.

Shift-CTRL-R

Shift-Cmd-R

CTRL-M

Cmd-M

This minimizes the window on OS X. On Windows, it only is
used for the Team Telephony window.

CTRL-T

Cmd-T

This enables always on top.

-

Shift-Cmd-M

This opens the Main window.

Shift-CTRL-C

Shift-Cmd-C

This opens contacts.

Shift-CTRL-F2

Shift-Cmd-F2

This opens call history.

Shift-CTRL-F1

Shift-Cmd-F1

This opens chat history.

Shift-CTRL-F3

Shift-Cmd-F3

This opens visual voice mail.

Shift-CTRL-D

Shift-Cmd-D

This opens the dial pad view.

Shift-CTRL-W

Shift-Cmd-W

This opens the web button view.
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This mutes the client (while in a call).

This retrieves your parked call.

This opens your My Room.

Appendix B: Guest Client Usage
This section provides more hands-on information about guest client usage.
1) Right-click on the My Room icon to copy the guest join link and send it to a guest via
email or other means.

Figure 2 Copy Guest Join Link Menu Option

2) The guest can open the link in one of the supported browsers, enter their name and
password, and then click Join Room.

Figure 3 Login Screen for Join Room

3) Once you click on Join Room, you see a badge on your My Room icon (as shown in
the following figure).
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Figure 4 My Room Icon – Guest Request Badge

4) Open your My Room and accept the guest request.

Figure 5 My Room – Accept Guest Request

You can also accept or decline join requests from the pop-up notification as shown in
the following figure. This pop-up notification is shown only if you already have your
My Room open.

Figure 6 Accept/Decline Request Pop-Up
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5) The guest is allowed into your room and can now participate in multi-user chat with
other participants in the room (as shown in the following figure).

Figure 7 My Room Window – Guest Chat
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If your service has enabled WebRTC support, then the guest can join the audio/video
portion of the session by clicking on the audio or video button. This feature is only
available on certain browsers and the user must grant access to their camera and
microphone by clicking Allow (as shown in the following figure).

Figure 8 Allow Access to Camera and Microphone Access

The guest can switch between audio and video mode by clicking on the video icon. They
can also mute and end the call by clicking on the mute and end call icons respectively.

Figure 9 My Room Window Icons

The guest can show or hide their self-view by clicking on the
corner of the video.

icon in the top left

6) You can start your desktop share from the desktop client and the guest then sees it.
The video call is resized and moved to the top left.
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Figure 10 My Room – Desktop Share with Video Call

7) The guest can also request the conference bridge to call them by entering a phone
number and clicking on the Call Me button. The Call Me Now feature must be
enabled for this to be available.

Figure 11 Additional Call Options

The guest can also manually call the conference bridge directly by using the provided dialin information.
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Appendix C: Skype for Business Integration
This section provides more hands-on information about Skype for Business (WorkTime
Skype for Business) integration usage.
The required startup procedure is as follows (reversing the order in which WorkTime
Skype for Business and WorkTime UC Desktop are started will not work):
1) Start WorkTime Skype for Business.
2) Start WorkTime UC Desktop. You can have it minimized or in the foreground.
The original intended use case for WorkTime Skype for Business integration was to use
WorkTime Skype for Business for presence and chat and on-net (VoIP) calls while
WorkTime UC Desktop would be used for off-net calls with presence and chat turned off.
However, many deployments keep the full presence and chat functionality of WorkTime
UC Desktop. WorkTime UC Desktop supports presence synchronization between
WorkTime Skype for Business and WorkTime UC Desktop for most presence statuses.
The following sections describe the ways to make various kinds of calls.
On-Net Calling
To make an on-net call:
1) Select a WorkTime Skype for Business contact and click the call button. Alternatively,
right-click a contact and select an on-net number.
2) Both the WorkTime Skype for Business main window and communications window
are visible (as shown in the following figures).

Figure 12 Making an On-Net Call
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Figure 13 Ongoing On-Net Call

Off-Net Calling
Off-net calling has more variations due to WorkTime Skype for Business remembering the
last number used to call a contact when clicking the call button (default action). As a
result, when in WorkTime Skype for Business calling another WorkTime Skype for
Business contact who is, for example, offline or in DnD status, using the call button (where
the default action is to call a WorkTime Skype for Business address) will fail and the
WorkTime Skype for Business call will not complete.
We can configure WorkTime UC Desktop to make the call instead in these cases.
To make an off-net call:
1) Select a contact, right-click and select an external number (see the following list for
the possible selections). The same outcome occurs when making an WorkTime
Skype for Business-to-WorkTime Skype for Business call while the called person is,
for example, offline or in the DnD state. Selecting a particular number from the rightclick menu will call that number, while using the call button only selects the number to
be called. The order in which the number is selected in this case is listed as follows
and cannot be changed:


Work phone



Mobile phone (can also be two mobile numbers)



Home phone



Other phone



WorkTime Skype for Business voice mail

2) WorkTime UC Desktop attempts to make the call instead of WorkTime Skype for
Business. Both the WorkTime Skype for Business main window and WorkTime UC
Desktop communications window are visible.
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Figure 14 Making an Off-Net Call

Figure 15 Ongoing Off-Net Call

Presence Synchronization
When WorkTime UC Desktop is configured to have full presence functionality and to also
act in WorkTime Skype for Business integration mode, making a call in WorkTime UC
Desktop may automatically change WorkTime UC Desktop presence to Busy –In Call. In
this case, a similar presence status is automatically selected on the WorkTime Skype for
Business side and vice versa.
The same principle also applies to other presence statuses. Changing presence on the
WorkTime Skype for Business side is detected by WorkTime UC Desktop and a similar
presence state is automatically shown on the WorkTime UC Desktop side. Note that the
different presence statuses used in WorkTime Skype for Business and WorkTime UC
Desktop are not 100% the same so an exact mapping is not possible. However, a status
variant is matched to a similar status variant on the other client. For example, a busy
status variant would be matched to a busy status variant.
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Appendix D: Configure USB Headsets
This section provides more information on configuring USB devices to function with
WorkTime UC Desktop.
In general on Windows, if “Default Communication Device” is defined in Windows settings,
it is selected over the “Default Device” by WorkTime UC Desktop for calls when several
audio devices are available (for example, USB headset and the integrated audio device on
the PC). However, when using headsets, you can select a separate device than the
headset for alerting incoming calls.
The following examples provide more information on how to define a default
communications device when a USB headset is available on the PC.
It is recommended to select “Use Default” in the Audio tab of WorkTime UC Desktop
Preferences for both input and output devices (as shown in the following figure).

Figure 16 Preferences Window
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1) To define the default communications device, make sure that the Sound settings in
Windows pertaining to “Recording” and “Playback” devices are correctly configured.
From the Sound applet, select the Playback tab.

Figure 17 Sound Window – Playback Tab

In this example, the user has a Plantronics BT300M (the USB dongle accompanying a
Voyager Legend UC) connected to their PC.
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2) Click Headset Earphone to highlight the device and click on the drop-down arrow
next to the Set Default button.

Figure 18 Sound Window – Playback Tab – Set Default
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3) Select Default Communication Device. The following screen is displayed.

Figure 19 Sound Window – Playback Tab – Default Set
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4) Next, click the Recording tab.

Figure 20 Sound Window – Recording Tab

WORKTIME UC DESKTOP GUIDE

5) Again, click on Headset Microphone, which represents the connected Plantronics
BT300M device, and click on the drop-down arrow next to the Set Default button.

Figure 21 Sound Window – Recording Tab – Set Default

6) Select Default Communication Device.
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Figure 22 Sound Window – Recording Tab – Default Set

7) Click OK to save the changes. The Sound window is dismissed and your device is
now ready to be used by WorkTime UC Desktop.
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Appendix E: Third-Party Software and Copyright
The following third-party software is used in WorkTime UC Desktop.
Chromium
Copyright (c) 2013 The Chromium Authors. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:
* Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer. * Redistributions in binary form must reproduce
the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution. * Neither the name of
Google Inc. nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
WebRTC
Copyright (c) 2011, The WebRTC project authors. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:
* Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.
* Neither the name of Google nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.
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THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.
OpenH264
Copyright (c) 2013, Cisco Systems. All rights reserved.
OpenH264 License: https://github.com/cisco/openh264/blob/master/LICENSE
Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:
* Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.
Blowfish
Based on a C implementation of the Blowfish algorithm by Paul Kocher
UUID - RFC4412
/*
** Copyright (c) 1990 - 1993, 1996 Open Software Foundation, Inc.
** Copyright (c) 1989 by Hewlett-Packard Company, Palo Alto, Ca. &
** Digital Equipment Corporation, Maynard, Mass.
** Copyright (c) 1998 Microsoft.
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** To anyone who acknowledges that this file is provided "AS IS" without any express or
implied warranty: permission to use, copy, modify, and distribute this file for any purpose is
hereby granted without fee, provided that the above copyright notices and this notice
appears in all source code copies, and that none of the names of Open Software
Foundation, Inc., Hewlett-Packard Company, Microsoft, or Digital Equipment Corporation
be used in advertising or publicity pertaining to distribution of the software without specific,
written prior permission. Neither Open Software Foundation, Inc., Hewlett-Packard
Company, Microsoft, nor Digital Equipment Corporation make any representations about
the suitability of this software for any purpose.
*/
MD5
Copyright (c) 1991-2, RSA Data Security, Inc. Created 1991. All rights reserved.
License to copy and use this software is granted provided that it is identified as the “RSA
Data Security, Inc. MD5 Message-Digest Algorithm” in all material mentioning or
referencing this software or this function.
License is also granted to make and use derivative works provided that such works are
identified as “derived from the RSA Data Security, Inc. MD5 Message-Digest Algorithm” in
all material mentioning or referencing the derived work.
RSA Data Security, Inc. makes no representations concerning either the merchantability of
this software or the suitability of this software for any particular purpose. It is provided “as
is” without express or implied warranty of any kind.
SHA-1
Copyright (c) The Internet Society (2001). All Rights Reserved.
This document and translations of it may be copied and furnished to others, and derivative
works that comment on or otherwise explain it or assist in its implementation may be
prepared, copied, published and distributed, in whole or in part, without restriction of any
kind, provided that the above copyright notice and this paragraph are included on all such
copies and derivative works. However, this document itself may not be modified in any
way, such as by removing the copyright notice or references to the Internet Society or
other Internet organizations, except as needed for the purpose of developing Internet
Standards in which case the procedures for copyrights defined in the Internet Standards
process must be followed, or as required to translate it into languages other than English.
The limited permissions granted above are perpetual and are not revoked by the Internet
Society or its successors or assigns.
This document and the information contained herein is provided on an “AS IS” basis and
THE INTERNET SOCIETY AND THE INTERNET ENGINEERING TASK FORCE
DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO ANY WARRANTY THAT THE USE OF THE INFORMATION HEREIN WILL
NOT INFRINGE ANY RIGHTS OR ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
SQLCipher
Copyright (c) 2008-2012 Zetetic LLC
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:
* Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.
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* Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.
* Neither the name of the ZETETIC LLC nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.
THIS SOFTWARE IS PROVIDED BY ZETETIC LLC ''AS IS'' AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL ZETETIC LLC BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.
Lesser General Public License (LGPL)
The following third-party libraries are in use based on LGPL license.
This software uses Qt libraries licensed under the GNU Lesser General Public License
(LGPL) 2.1.
Qjson – Copyright 2012 – Flavio Castelli
QXmpp – Copyright 2008-2011 The QXmpp developers
QCA – Copyright 2003-2007 Justin Karneges justin@affinix.com. Copyright 2004-2006
Brad Hards bradh@frogmouth.net
LGPL license are available at http://www.gnu.org/copyleft/lesser.html.
LGPL license is also available locally with this software, at the installation directory.
BSD license
The following software is used based on BSD license:
OpenSSL - Copyright 1998-2011. The OpenSSL Project.
License available at http://www.openssl.org/source/license.html.
Breakpad - Copyright 1998, Regents of the University of California
Breakpad license available at http://opensource.org/licenses/BSD-3-Clause.
Stackwalker - Copyright 2009, Jochen Kalmbach
License available at http://stackwalker.codeplex.com/license.
Apache license 2.0
The following third-party libraries are using Apache license 2.0:
Log4cxx - Copyright 2012 Apache Software Foundation.
License available at http://logging.apache.org/log4cxx/license.html.
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Non-restrictive license
The following third-party library is used based on its own non-restrictive license:
OpenLDAP - Copyright 2013, OpenLDAP Foundation.
OpenLDAP license is available online for review at
http://www.openldap.org/software/release/license.html.
OpenLDAP license is also available locally with this software at the installation directory.
Free software
The following free software is only used when third-party software is using the WorkTime
UC Desktop API via LGPL, MIT, BSD, or another license:
Tufao (LGPL2.1) – Copyright 2012 Vinicius dos Santos Oliveira vini.ipsmaker@gmail.com
Libcurl – Copyright 1996 - 2013, Daniel Stenberg, daniel@haxx.se
License available at http://curl.haxx.se/docs/copyright.html.
Tinythread++ - Copyright 2012 Marcus Geelnard
License available at http://opensource.org/licenses/zlib-license.php.
Picojson – Copyright 2009-2010 Cybozu Labs, Inc. Copyright 2011 Kazuho Oku
License available at https://github.com/kazuho/picojson/blob/master/LICENSE.
Easywsclient – Copyright 2012, 2013 dhbaird@gmail.com
License available at https://github.com/dhbaird/easywsclient/blob/master/COPYING.
The Qt Toolkit is Copyright (C) 2015 The Qt Company Ltd.
Contact: http://www.qt.io/licensing/
You may use, distribute and copy the Qt GUI Toolkit under the terms of GNU Lesser
General Public License version 3.
This license makes reference to version 3 of the GNU General Public License.
LGPL license are available at http://www.gnu.org/copyleft/lesser.html.
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Appendix F: Acronyms and Abbreviations
ACB

Automatic Callback

API

Application Programming Interface

CPU

Central Processing Unit

DTMF

Dual-tone multi-frequency

ECACS

Emergency Call Address Change Service

EULA

End-User License Agreement

FAC

Feature Access Code

FAQ

Frequently Asked Question

FMC

Fixed-mobile convergence

HD

High Definition

HID

Human Interface Device

LDAP

Lightweight Directory Access Protocol

LGPL

Lesser General Public License

MWI

Message Waiting Indication

RAM

Random Access Memory

SIP

Session Initiation Protocol

UC

Unified Communications

UI

User Interface

URL

Uniform Resource Locator

VoIP

Voice over IP

WebRTC

Web Real-Time Communication

XMPP

Extensible Messaging and Presence Protocol

Xsi

Xtended Services Interface
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